ABSTRACT

Building on other studies and reports, we describe an educational laboratory exercise in which students analyze the movement of the ciliated protozoan Tetrahymena thermophila, using free video-capture and image-analysis software (ImageJ), along with a relatively inexpensive ($45–70) digital microscope camera that is USB 2.0 compatible. Specifically, students record Tetrahymena activity under different control and test conditions, and they later use ImageJ to analyze the movement patterns. While this technique is demonstrated to show how methanol affects Tetrahymena behavior, students can use the approach to examine activity under a variety of circumstances, enabling them to conduct their own inquiry-based experiments in lab or as part of a larger independent research project.

Key Words: Ciliated protozoa; Tetrahymena thermophila; swimming and movement; video analysis; ImageJ; student laboratory exercise; inquiry-based research projects.

Introduction

Tetrahymena are an excellent model organism for teaching basic scientific research skills, especially in a high school or college setting (Bozzone, 2000; Smith et al., 2012). For example, these single-cell protozoans have been used to study a wide variety of phenomena, including phagocytosis (Bozzone, 2000; Gray et al., 2012), movement patterns in response to various stimuli (Rodgers et al., 2008; Hennessey & Lampert, 2012), and the effects of different toxins or pollutants on living organisms (Chen & Leick, 2004; Lang & Kohidai, 2012). In fact, given the wealth of primary literature on these microorganisms as well as the ease with which they can be raised and kept, Tetrahymena are particularly well suited for providing students with active learning experiences, in which they can design their own independent research projects and develop their investigative and analytical skills (Bozzone, 2000; Smith et al., 2012).

However, many of the Tetrahymena experiments discussed in the literature use expensive equipment (e.g., inverted, fluorescence, or confocal microscopes and advanced digital cameras) that further require sophisticated protocols for cell preparation and viewing—all of which can place these methods out of reach for many teachers and students. Fortunately, several teams of educators and researchers (such as the ASSET group out of Cornell University and the Ciliate Genomics Consortium) have begun to develop Tetrahymena lab modules for use in the primary and secondary schools as well as at the college level (Smith et al., 2012).

In this spirit, we build upon a number of prior studies and reports to describe an economical yet engaging laboratory exercise in which students use a relatively inexpensive digital microscope camera to take short videos of Tetrahymena under different control and test conditions. Students then analyze these videos using ImageJ (a free image-processing and image-analysis program that is widely used in the biological sciences) and can later prepare posters or papers discussing their methodology and results.

While used here to show the effects of methanol (a common pollutant) on Tetrahymena movement, this exercise can be adapted in numerous different ways. For example, students can complete the activity in a single lab period, or over several weeks (or an entire semester) for more substantive research projects. In the process, students can receive the opportunity to develop their basic laboratory skills, review the primary literature to formulate their own research questions, design and conduct their own experiments, analyze and interpret the data they have collected, and prepare scientific reports, posters, or presentations discussing their methodologies and results. As such, the exercise can provide students with the types of meaningful experiences and opportunities in the sciences that
many educators have advocated, especially if incorporated into an introductory or upper-level biology course or a semester-long independent research program (Pu, 2010; Bangera & Brownell, 2014; Harvey et al., 2014).

○ Supplies & Equipment

The basic laboratory equipment needed for this activity includes compound microscopes, pipettes, flasks or other containers to hold the growth medium, test tubes or microfuge tubes for the Tetrahymena samples, glass slides, and an optional squirt bottle for rinsing out the slide chambers (Figure 1). All glassware should be cleaned with Alconox and rinsed thoroughly (≥5 times) in advance using deionized or distilled water, and all solutions should be made with deionized or distilled water, as well (Bozzone, 2000).

Students will further need computers (whether their own or those belonging to the school) that are USB 2.0 compatible and loaded with the following software:

- Celestron’s Digital Microscope Software for Windows, version 2.0: http://www.celestron.com/browse-shop/microscopes/microscope-accessories/imagers/digital-microscope-imager (click on the “Support” option in the lower right portion of the screen to access the file)

Although we describe how to record Tetrahymena movement using a 2.0 megapixel Celestron digital imager (model no. 44421) and its accompanying Windows-only software, other digital microscope cameras are available, as are other video capture programs (see the ‘Helpful Hints’ section for a brief description of some of these alternatives). In addition, students will need Loctite Fun-Tak and single-edged razor blades (or other similar materials) to make the slide chambers that will hold the Tetrahymena.

Finally, at the start of the lab, students should be given separate microfuge tubes containing a 1 mL sample of Tetrahymena cells from a three-day-old culture, 200 µL of deionized or distilled water, and 200 µL of mild methanol solutions (e.g., 1.0% and 2.0% by volume), which should be prepared fresh daily. Because methanol is both toxic and flammable, please follow proper safety procedures and wear the appropriate protective equipment when handling the substance, and have students do the same.

○ Growth Medium & Tetrahymena Cultures

Bacteria-free cultures of Tetrahymena can be obtained from several sources, including Carolina Biological Supply, the Tetrahymena Stock Center, and the American Type Culture Collection (Bozzone, 2000). The cultures can be grown in a modified Neff medium (Cassidy-Hanley et al., 1997) consisting of 0.25% proteose peptone (2.5 g/L), 0.23% yeast extract (2.5 g/L), 0.5% glucose (5.0 g/L), and 33.3 µM FeCl₂ (3.33 mL/L of 10 mM FeCl₂), or, if resources are limited, a 2.0% proteose peptone solution (i.e., 2.0 g in 100 mL of distilled or deionized water, Bozzone, 2000; Gray et al., 2012).

To make inoculated cultures, add 25 mL of medium to separate 125 mL flasks (or other suitable containers) and autoclave them on the “liquid” cycle for 20 minutes (Bozzone, 2000). The flasks of sterilized medium can then be stored at room temperature for up to one month. Absent an autoclave, we have found that fresh medium can also be placed in glass containers with their plastic caps loosely on and heated in a microwave on “high” for one to two minutes, which should prevent bacterial growth for at least five days – a sufficient time for this exercise.

After the medium has cooled, pipette 500 µL of stock Tetrahymena solution into each flask, and let the culture sit at room temperature for three days to ensure a sufficient cell density. Alternatively, cultures can be placed on a shaker table (set at 60–80 rpm) and/or in an incubator (set at 30°C) for 24–48 hours.

Finally, before lab, cultures should be checked using a 4× objective lens and the Celestron digital imager to ensure a sufficient cell density for meaningful experiments (ideally, between 15 and 30 cells on the screen at any given time). To increase the density of a sample, spin down 10 mL of culture in a clinical centrifuge for one minute on a setting of “4” (~800 g), pour off the excess supernatant, and then add an appropriate volume of fresh medium. Be sure to test each methanol solution before lab as well to gauge (or adjust) their strengths.

○ Constructing the Slide Chamber

To build the slide chamber that will hold the Tetrahymena cells, roll a small ball of Loctite Fun-Tak into a long, thin strip, and then cut it into two equal lengths (Figure 2A, B). Next, stretch each piece across a standard glass slide with ~2 cm between the strips (Figure 2C). Then press another glass slide on top of the first, leaving a small “lip” at the top (~0.5 cm wide), where Tetrahymena samples can later be injected (Figure 2D, E). Finally, remove any excess Fun-Tak with a single-edged razor blade (Figure 2F). Depending on their exact dimensions, such 2 × 2 cm chambers should hold 50–100 µL of solution. Students can make either one chamber and reuse it for each

Figure 1. The basic equipment needed for this lab exercise, including a computer that is USB 2.0 compatible.
experiment after a thorough rinsing (e.g., five times) or three separate chambers (one for each solution).

Because these chambers are typically only a few cells thick, students can easily focus on the *Tetrahymena* cells under the microscope. Moreover, unlike a cover slip, which sinks over time and constrains the movement of the cells, these chambers generally allow the cells to swim freely for ≥60 minutes (providing the opportunity to observe *Tetrahymena* movement over long periods if students so desire). However, with time, the cells do accumulate near the air–water interfaces, given the presence of oxygen there.

### Installing the Digital Camera

To activate the digital camera, remove an eyepiece from a standard compound microscope and insert the digital imager in its place (Figure 1). Then plug the cable into a computer with a compatible USB 2.0 port and click on the “MicroCam2” icon to start the program (C:\Program Files (x86)\EasyOn\Digital Microscope Suite).

To enlarge the view screen, open the “Systems Settings” window (File → Settings) and select the 640 × 480 option in the “Video Resolution” drop-down menu (Figure 3). Also, uncheck the “With Audio” box to disable audio recording while making a video.

By default, the Celestron program will automatically create a “Microscope Media” folder in the “Documents” library of a Windows computer. However, this location can be changed in the bottom of the Systems Settings window (Figure 3).

### Recording a Calibration Image

Before starting the experiment, record a short video of a standard micrometer stage for later calibration using the 4x objective lens (see Figure 11). This will also bring the microscope into general focus.

### Preparing a Sample

To prepare the control sample, pipette 100 µL of *Tetrahymena* culture into an empty microfuge tube and then add 100 µL of deionized or distilled water, gently suspending the solution (e.g., five times) to ensure a thorough mixing. Then, pipette 50–100 µL of that mixture into the slide chamber (enough to fill the space between the two strips of Fun-Tak). Once finished, place the chamber under the microscope, find an area near the center of the slide, focus the image, and turn off the microscope light. Further note the time (to record a video 10 minutes later).

To prepare a test sample, repeat the steps above, only add 100 µL of either 1.0% or 2.0% methanol (by volume) to a new microfuge tube containing a fresh 100 µL sample of *Tetrahymena* culture. This procedure will dilute the methanol solution by one-half, making the resulting mixtures 0.5% and 1.0% methanol (by volume), respectively.

### Recording Videos

Wait 10 minutes before recording a video to afford the *Tetrahymena* sufficient time to adjust to their new environment. Then, turn on the microscope light and record 30 seconds of activity near the center of the chamber (still using the 4x objective lens). To start or stop recording, click on the red “record” button in the bottom center of the Celestron window (Figure 3).

### Converting Videos

To process and analyze a video in ImageJ, the file must first be converted into a specific AVI format (called an “MJPEG”). While we use Any Video Converter for this process, other programs are also acceptable (e.g., Hennessey & Lampert [2012] recommend using VirtualDub).

To load a file into Any Video Converter, click on the “+” button in the center of the main window (Figure 4). For the output format, select the “Customized AVI Movie (.avi)” option from the drop-down menu near the upper right corner of the window (Figure 4).
Next, in the “Basic Settings” tab located in the lower right corner of the program, set the Video Size to “640 × 480” to correspond to the Video Resolution selected for the digital imager (Figure 4, top right). Then click on the “Video Options” tab below “Basic Settings” and set the Video Codec field to “MJPEG” and the frame rate to “20,” which is the number of frames per second (fps) captured by the Celestron software (Figure 4, bottom right). Note that if a different program is used to make the recordings, a different frame rate and video resolution might be applicable.

Finally, click on the “Convert Now” button in the upper right corner to convert the video into an AVI file, which will appear in the Videos\AnyVideoConverter\AVI folder automatically created by the program.

**Viewing & Analyzing Videos in ImageJ**

Converted videos can then be viewed and analyzed in ImageJ using “Z projections,” which are akin to time-lapse videos that show the paths traveled by each *Tetrahymena* (Hennessey & Lampert, 2012). To make a Z projection, open a converted video in ImageJ (File → Open) and indicate the specific frames to be viewed (Figure 5). The Celestron software records at 20 fps, so the first second of activity corresponds to frames 1 to 20, the next second of activity to frames 21 to 40, and so on.

Next, threshold the initial image (Image → Adjust → Threshold) to identify the starting position of each *Tetrahymena* (Figure 6). Specifically, leave the threshold color on “Red” and uncheck the “Dark Background” box in the Threshold window, which will highlight the individual cells instead of the background. While the “Default” threshold setting will usually highlight all of the *Tetrahymena* on the screen, try other thresholding methods if not all the cells are captured.

After thresholding the image, generate a Z projection (Image → Stacks → Z Project). By selecting the “Min Intensity” setting from the Projection Type drop-down menu (Figure 7), students can create images that show dark traces of the *Tetrahymena* paths on a light background (Hennessey & Lampert, 2012). Alternatively, by
selecting the “Standard Deviation” option, the paths will appear as white traces on a dark background (not shown).

Each projection should then be saved with a meaningful name and later analyzed by the students (Figure 8). For a one-day lab, students should create at least three projections per video (more if time permits). For a multiweek lab or semester-long research project, additional Z projections would be appropriate.

### Collection & Analyzing the Data

Although there are numerous movement patterns that students can analyze using this approach, we discuss two here: path type and path length (or speed). Identifying and counting the different types of paths traveled by the *Tetrahymena* (straight, curved or circular, bent, not moving, etc.) is straightforward, and students can use ImageJ’s paintbrush tool to highlight paths with specific colors, which can simplify the process (Figure 9).

Students can then enter their data into a spreadsheet program (e.g., Microsoft Excel) to create a column graph (or other chart) showing the relative frequency of these paths (Figure 10). For more advanced labs, students can further calculate the standard deviation or standard error for each of these categories and/or conduct tests of statistical significance (e.g., by running an ANOVA or other appropriate analysis on the data).

Measuring the lengths of these swim paths in ImageJ to calculate the corresponding speeds (speed = distance / time) is also fairly simple and can be accomplished in two steps. First, set the scale in ImageJ by opening up the calibration video, drawing a straight line between the 0 and 1.0 mm marks, and entering the “known distance” (i.e., 1.0) and “unit of length” (i.e., mm) in the “Set Scale” window (Analyze → Set Scale) (Figure 11). In addition, make sure that the “global” box is checked, so that the given scale applies to all images generated during the experiment. Next, using ImageJ’s freehand line-drawing tool, measure the distance traveled by individual *Tetrahymena* during the given time period (examining only those paths that are shown completely on the screen). Specifically, draw a line along a path and press Control+M to measure that distance (Figure 12). ImageJ will then generate a spreadsheet containing this (and other) measurements (Hennessy & Lampert, 2012).

After finishing their measurements and saving their results, students can open the file in Microsoft Excel (or some other spreadsheet program) to analyze the data. For example, using the Data Analysis ToolPak in Excel (https://support.microsoft.com/en-us/kb/214269), students can generate relative frequency histograms to show the distribution of *Tetrahymena* speeds from the control and test solutions. These distributions can then be displayed on the same graph using “smooth” or “straight line” scatterplots to show the progressive effects of the chemical treatments (Figure 13).

We suggest preparing histograms of *Tetrahymena* swimming speeds in this way because we believe that they can provide students with an overall picture of the activity in each solution, especially when viewed next to a column graph showing the relative frequency of different path types (Figure 10). However, since there are numerous other movement patterns (and corresponding metrics) that can be analyzed and many different ways to display the resulting information, we suggest engaging students before or during lab to help them think critically about the possibilities and what their results may mean for the “bigger picture” (e.g., how pollutants might affect other living organisms in the environment or the eukaryotic cells in their own bodies).

### Additional Projects

Given the versatility of this exercise, it can be adapted to examine the acute or chronic effects of numerous physical conditions or chemical treatments on *Tetrahymena* movement. For example, students can examine how *Tetrahymena* behavior varies with age (e.g., cells that are 3, 4, or 5 days old), nourishment (e.g., cells that have been starved for 4, 8, or 16 hours), temperature (e.g., cells that have been incubated at 20°C, 25°C, and 30°C), or pH level (e.g., 4.0–9.0). Alternatively, students can investigate how different chemicals affect the movement of *Tetrahymena*, and some possibilities include ethanol, caffeine, heavy metals (e.g., chromium, copper, lead, zinc), or different synthetic or essential oils. Students can also explore the effects of different commercial or household items on *Tetrahymena*, such as laundry detergents, chlorine bleach, or other cleansers; various pesticides, herbicides, or fertilizers; coffee, cola, or other soft drinks; natural or processed food products;
or even over-the-counter medication or supplements. For even more ideas, consider visiting the ASSET website (https://tetrahymenaasset.vet.cornell.edu) or reviewing some of the articles included in the references below, especially the work of Sauvant et al. (1999) as well as the methods paper by Hennessey and Lampert (2012).

In fact, given the wealth of published research on Tetrahymena, students can review the primary literature to formulate their own research questions or design their own experiments. Students can further present their results in the form of a poster or a formal paper, which could be submitted for publication in a student or other journal (depending on the nature and rigor of their study). In the process, students can begin to develop many of the skills that are critical in the sciences, such as learning how to formulate hypotheses and design experiments to rigorously test them; how to collect and analyze the resulting data; how to clearly and concisely report the subsequent results; and, importantly, how to collaborate and cooperate with the members of their research team (i.e., lab group) to accomplish these various tasks. As such, the exercise can provide students with many different types of meaningful experiences and opportunities in the sciences, whether as part of a biology course or independent study program. In addition, because the exercise can be tailored as an open-inquiry activity (in which students formulate their own research question and design an experiment to answer it) or as a guided-inquiry exercise (in which the teacher plays more of a role in directing the students in their work), the activity is well suited for students at many different levels. We further invite readers to adapt or expand upon the exercise to provide students with challenging and engaging experiences of their own, and we look forward to seeing the results.

**Figure 8.** Z projections showing 1.5 seconds (30 frames) of activity in the control (left) and test solutions of 0.5% and 1.25% methanol (middle and right, respectively) after 10 minutes, using a 4x objective lens.

**Figure 9.** Using the paintbrush tool in ImageJ to identify different types of paths with different colors.

**Figure 10.** A sample column graph in Microsoft Excel showing the effect of methanol on the shape of a Tetrahymena’s path.

**Figure 11.** Setting the scale in ImageJ (Analyze → Set Scale) using the straight-line tool.
Helpful Hints

Although most aspects of this lab are fairly straightforward, there are a few areas that require special attention to ensure that the exercise runs smoothly.

First, for a one-day lab, consider using substances that have known effects to avoid a frustrating or disappointing experience among students. Also, if examining the effects of novel treatments (e.g., energy drinks, hot sauce, perfumes or colognes, etc.), we suggest initially varying concentration levels in decade increments (e.g., 10%, 1.0%, 0.10%, etc.) to identify a narrower range of values that will hopefully lead to substantive results.

Second, students may need to create 2 projections of different lengths for their control and test solutions to identify meaningful activity on the screen (e.g., 1.0 seconds for the control vs. 2.0 or 3.0 seconds for the methanol solutions). If so, students should keep these different time periods in mind when calculating the swimming speeds in their respective samples.

Third, for chambers with uniform dimensions, consider using flat glass capillary tubes (e.g., 0.100 × 2.00 × 50.0 mm) placed on a standard glass slide. However, because such chambers are quite fragile and relatively expensive, they may be more suitable for an independent research project than for a general lab activity.

Finally, if readers are interested in other types of hardware or software for this exercise, AmScope, Moticam, and OMAX also make digital microscope cameras. However, these brands may be more expensive than the Celestron imager, especially for comparable 2.0 megapixel models (e.g., $65–$350 on Amazon). These cameras may further use their own proprietary software, which might be more advanced than the Celestron program. There are also other free video-capture programs available that will work with the Celestron imager, such as the Windows-based Free Cam Recorder or MyCam software. These two programs can further save videos directly in the appropriate AVI and MJPEG formats, eliminating the need for the Any Video Converter program.

Additional Materials

For a PDF version of a lab manual describing this activity in greater detail, please visit http://pages.stolaf.edu/opn-lab/experiments/.

Acknowledgments

From the St. Olaf College Biology Department, we would like to thank Eric Cole for supplying us with Tetrahymena cultures, as well as Joy Broin and Jo Tran for their helpful comments on the manuscript. The authors further declare that they have no conflicts of interest related to any product, brand, company, website, or other item discussed in this article. In fact, we encourage readers to experiment with different hardware, software, or other materials to improve upon this exercise.

References


JOHN GIANNINI is an Associate Professor of Biology at St. Olaf College in Northfield, MN 55057; e-mail: giannini@stolaf.edu. CHRIS STEWART is a Research Associate at St. Olaf College who works with Professor Giannini; e-mail: stewartc@stolaf.edu.

The AGSC can provide classrooms with living materials and educational resources to examine topics such as: development, evolution, ecology, transgenic methods, and genome editing.

Our mission is to serve biology research programs and educators by providing experimental material and expertise and by encouraging and facilitating the exchange of information and ideas.

To learn more about how this resource can work for you, visit us at: www.ambystoma.org/genetic-stock-center